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Chapter 7. Move Quickly 
Around Documents

[Sample chapter from Write Faster With Your Word Processor (http://
www.Geoff-Hart.com/books/write-faster/write.htm)]

One nice thing about mouse-driven interfaces is how easy 
it is to move around: simply scroll to the right location using 
the scroll bar or the mouse’s scroll wheel, then click the mouse 
where you want to begin working. Unfortunately, repeatedly 
moving your hands between keyboard and mouse wastes consid-
erable time; it may only cost you a second or three each time you 
grab the mouse and then return your hands to the keyboard, but 
if  you do that hundreds or thousands of  times per day (and you 
do!), the wasted time adds up. This is doubly true if  you’re us-
ing the awkward pointing devices found on most laptop comput-
ers. Since most writers are skilled typists, it’s more productive to 
keep your hands on the keyboard even when you need to move 
around. Yet many writers never master this skill and remain ig-
norant of  the many powerful navigation shortcuts that are avail-
able.

In this chapter, I’ll present the most efficient keyboard-based 
tricks for moving around a document while writing or revising, 
as well as a few non-keyboard or hybrid (keyboard plus mouse) 
tricks. Once you’ve mastered these techniques, Chapter 8 will 
teach you how to use them to select text more efficiently. Be-
cause both Windows and the Macintosh have increasingly stan-
dardized their keyboard commands across programs, these tips 

http://www.Geoff-Hart.com/books/write-faster/write.htm
http://www.Geoff-Hart.com/books/write-faster/write.htm
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will work in most software, with occasional variations. If  your 
software doesn’t support a particular useful shortcut, check its 
documentation or search the Web to see if  you can discover an 
equivalent command. Alternatively, record a macro that will 
achieve the same result. (See Chapter 14 for details of  how to re-
cord macros.)

Why bother using the keyboard? A colleague once 
challenged me to prove that the keyboard really was more 
efficient than the mouse. So I timed myself  using mouse 
and keyboard, and found that learning just three new key-
board shortcuts for the most frequent kinds of  moves saved 
me an average of  10 minutes per day. You can imagine 
that this encouraged me to learn all the other shortcuts de-
scribed in this chapter. I haven’t calculated the overall time 
savings, but I can tell you that this freed up enough time for 
me to take a 30-minute nap at lunch and still have time to 
finish the same amount of  work per day.

Note that you can access any menu command from the key-
board. Chapter 5 describes how to do this in the section Nav-
igating menus from the keyboard, and describes how to create new 
shortcuts in the section Keyboard Shortcuts. Word for Windows lets 
you jump between tabs in a dialog box by pressing Alt plus the 
letter assigned to the specified tab. In both Windows and Mac 
versions, pressing Tab and Shift+Tab will move forward and 
backward, respectively, between the fields in a dialog box.
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Moving among directories in the Open File dialog 
box: To move among the fields in the Open File dialog box, 
press the Tab key (or Shift+Tab to move in the opposite 
direction). To move upwards one level in Windows, press 
Alt+↑; for the Mac, press Command+↑.

Note that in this chapter, I’ve used a shortcut to describe the 
keystrokes for the Windows and Mac versions of  Word (respec-
tively): Control/Command, followed by the other key to press.

Small Jumps
Most cursor movements during writing and revision are be-

tween words, sentences, or paragraphs. You’ll make these jumps 
so often that it makes no sense to be constantly interrupting your 
work to grab the mouse. Learn the following keystrokes instead:
•	 Next or previous word: Control/Command + → and 

Control/Command + ←, respectively.
•	 Beginning or end of  line: Home and End keys, respec-

tively.
•	 Beginning or end of  sentence: There’s no universal 

keyboard shortcut for doing this, so you’ll have to research 
the shortcut for each program. (I’ll describe how to create 
this shortcut in Word after this list.)

•	 Beginning or end of  paragraph: Control/Command + 
↑ Control/Command + ↓, respectively.
Word includes functions that jump between sentences, but 

to use them from the keyboard, you must define new keyboard 
shortcuts:
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•	 Open the Customize Keyboard dialog box, as described in 
Chapter 5.

•	 Choose the template or file that should store these custom-
izations. (Choose Normal.dotm to make the shortcut avail-
able in all documents.)

•	 Under Categories, select All Commands, then scroll through 
the command list until you reach SentLeft, the command for 
“move to the beginning of  a sentence”. You can instead click 
inside the command list and start typing this name; Word 
will scroll automatically to that part of  the command list as 
you type.

•	 In the field labeled Press new shortcut key, type the new key 
combination (e.g., Control+Alt+Home). Click Assign to im-
plement the new shortcut.

•	 Repeat this process for SentRight, the command for “move 
to the end of  a sentence” (e.g., Control+Alt+End).

•	 Click OK to close the dialog box.

Start of  the sentence is multilingual: Both the Sen-
tLeft command and the SentRight command also move to 
the start and end of  the sentence (respectively) in right-to-
left languages.

Moving Within Tables
With the text cursor inside a table, you can use variations of  

the Tab key to move within the table:
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•	 Move to the next or previous cell: Press the Tab key 
and the Shift+Tab combination, respectively.

•	 Move to the first and last cells of  a column: In Win-
dows, press Alt+PageUp and Alt+PageDown, respectively. 
On the Mac, use Control+PageUp and Control+PageDown.

•	 Move to the first and last cells of  a row: In Windows, 
press Alt+Home and Alt+End, respectively. On the Mac, 
use Control+Home and Control+End instead.

Mastering tables: For tips on how to create and revise 
tables, see the article Mastering Word’s Tables on my Web site.

Moving Around Documents That 
Contain Tracked Changes

I’ll discuss details of  using the Track Changes feature to 
work with an editor in Chapter 15. Here, I’ll describe a few use-
ful tricks for moving efficiently around documents that contain 
tracked changes. These movement shortcuts rely on two tricks: 
first, Word can move directly to tracked changes and skip the in-
tervening text, and second, Word can selectively display or con-
ceal certain types of  tracked changes, which lets you ignore the 
concealed changes during your movements.

For a lightly edited document, you can move rapidly to the 
next or previous changes by clicking the Next Change or Previous 
Change icons in the Ribbon’s Review tab. These commands skip 
all intervening text between the cursor position and the next or 
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previous tracked change. You can move even faster if  you create 
keyboard shortcuts for these commands:
•	 Open the Customize Keyboard dialog box, as described in 

Chapter 5.
•	 Under the Categories heading, select Review tab (Windows) 

or All Commands (Mac).
•	 Under the Commands heading, scroll down to NextChan-

geOrComment 
•	 Create a keyboard shortcut (e.g., Control+Alt+↓).
•	 Click Assign to implement the new shortcut.
•	 Repeat this process, but scroll down to PreviousChan-

geOrComment and choose the keyboard shortcut (e.g., Con-
trol+Alt+↑).

•	 Click OK to close the dialog box.
In documents that have been heavily edited using revision 

tracking, these movements can be inefficient because of  the 
many changes. Instead, select the Ribbon’s Review tab, open 
the Show Markup menu (Windows) or the Markup Options menu 
(Mac), and deselect any categories of  changes that you (tempo-
rarily) don’t want to show. For example, if  you deselect all op-
tions except format changes, the shortcut keystrokes I’ve just 
described will move you to the next or previous format change 
and will ignore all insertions and deletions.

If  you want to ignore all tracked changes while you move 
around (e.g., if  you want to check the positions of  graphics in 
a page layout), open the Display for Review menu in the Rib-
bon’s Review tab and select No Markup so that only the results 
of  your edits appear on the screen. Move to your destination 
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using any of  the movement shortcuts described in this chapter, 
then display your tracked changes again by selecting All Mark-
up from this menu. If  you do this often, it’s worthwhile defining 
a keyboard shortcut: under All Commands, scroll down to Show-
InsertionsAndDeletions and assign a keystroke. I use Control+-
Shift+D to “shift the display” between showing and concealing 
the tracked changes. 

Moving between comment balloons: Word 2019 re-
moved the handy ability to move the cursor from inside 
the balloon for one comment to inside the balloon for the 
previous or next comment using Control/Command plus 
the ↑ and ↓ keys. Fortunately, you can restore these key-
strokes by customizing the keyboard. (Follow the instruc-
tions before this note for moving between tracked changes.) 
Under the category All commands, scroll down to Next-
Comment and PreviousComment, and choose a keyboard 
shortcut for these commands. Alternatively, under the Re-
view tab’s Markup Options menu, deselect all options except 
Comments. You can now move from comment to comment 
using the Review tab’s Previous Change and Next Change 
icons, or create keyboard shortcuts for those commands.

Moving Using the Search Tools
Many of  the most useful movements you’ll need to make 

while revising a manuscript aren’t built into your word proces-
sor. The solution? Use the Find dialog box to do the hard work 
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for you! The basic principle is simple: word processors can move 
to any character or pattern that you can find using the Find dia-
log box (see Chapter 12 for details), so all you need to do is fig-
ure out how to find what you’re looking for. If  you’ll do this often 
(e.g., to move to the next chapter’s title), record a macro that 
follows your instructions on how to find that information. (See 
Chapter 14 for instructions on how to record a macro.) Use the 
following steps:
•	 Open the Find dialog box (Control/Command+F).
•	 Type the character or pattern you want to find. For example, 

type “Chapter” if  you want to move to the next chapter title.
•	 Click the Find Next button to move to the next instance of  

that character or pattern.
•	 Close the dialog box.
•	 If  you’ve recorded a macro that stores this series of  steps, as-

sign a keyboard shortcut to the macro. (See the descriptions 
earlier in this chapter for details.)
Using this approach, I created many remarkably useful ways 

to zip around a document at top speed based on things I fre-
quently need to move to while I’m editing someone else’s man-
uscript or revising my own. Here are some examples to inspire 
you to create your own movement shortcuts, and the keyboard 
shortcuts I defined for each of  them:
•	 Next or previous punctuation: I created search macros 

to find periods (Control+.), commas (Control+,), semicolons 
(Control+;), and colons (Control+:).

•	 Numbers: Since I mostly do scientific editing, I deal with 
many numbers. Word’s code to search for a number is ^#, 
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and the keyboard shortcut I use is Control+3. Memory aid: 
the number sign (#) is above the 3 on the keyboard.

•	 Brackets: My authors insert many parenthetical comments 
and equations, so I’ve created search functions for each 
bracket type; the keyboard shortcut is Control plus the spe-
cific bracket; for example, Control+[ takes me to the next 
opening square bracket.

•	 Years: Since I often need to check literature citations based 
on the author/date citation method, I use the search text 
^#^#^#^# (Word’s code for “find four numbers in a row”), 
and implement this search using the keyboard shortcut Con-
trol+Y. Memory aid: Y = year.
I also created keyboard shortcuts to perform most of  the 

same searches, but moving backwards through the document. 
All I needed to do was to click the Find Previous button while I 
was recording the macros. To take advantage of  the keyboard 
shortcuts I’ve already memorized, I simply added the Shift key 
to each of  these shortcuts; for example, Control+Shift+[ moves 
to the previous [. Depending on the type of  writing or revision 
you do, you’ll likely have a whole series of  things you need to be 
able to reach quickly. Pay attention to the kinds of  movements 
you’re doing most frequently, and create search macros that help 
you perform those moves in a single keystroke.
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Bigger Jumps
Sometimes you need to jump farther, such as between 

screens, pages, or sections. Rather than scrolling, learn the fol-
lowing keystrokes instead:
•	 Next or previous screen: PageUp or PageDown, respec-

tively.
•	 Section break or manual page break: Open the Find 

dialog box (Control/Command+F) and search for the code 
that Word uses to define breaks. Word uses ^m for a manu-
al page break; ^b for a section break, and ^l for a manual line 
break.

•	 Graphics: Open the Find dialog box (Control/Com-
mand+F) and search for the code Word uses to define a 
graphic: ^g.

•	 Beginning or end of  a document: Control/Com-
mand+Home or Control/Command+End, respectively.

•	 A specific section: Open the Find dialog box (Control/
Command+F) and type a word or phrase that appears for 
the first time in that section. For example, if  you want to 
move to the next chapter and each chapter title begins with 
the word Chapter, type that word as the search term. If  you 
know the chapter number, add that to the search term.
Chapter 5 describes Word’s Outline and Navigation Pane 

view modes. Both let you move quickly around a document 
when you don’t remember details of  a title or heading. Because 
Outline view allows you to expand and collapse the display to 
show and conceal some of  the document’s headings and their 
subordinate text, it also lets you eliminate the distance between 
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consecutive headings when you scroll or use keyboard shortcuts. 
You can then move from one heading to the next with a single 
keystroke (e.g., by pressing the down arrow key), and once you 
arrive, you can expand the outline again and resume your edit-
ing. With the Navigation Pane displayed, you can click anywhere 
in that pane to move to that position in the file, and immediately 
begin editing from that point. Although this requires the mouse, 
the potentially large distance you’re moving makes this approach 
efficient.

Finding a section by its title: Word lets you search for 
words that appear at the start of  a new paragraph by typ-
ing ^p (the code Word uses for a carriage return) before the 
word. For example, searching for ^pChapter will not find 
phrases such as “see Chapter 10” in mid-sentence. Simi-
larly, if  you need to find a word that has been forced onto 
the next line using a manual line break (by holding the Shift 
key and pressing Return or Enter), type ^l (lower-case L) 
before the word instead. If  the word has been forced to the 
beginning of  a new page or section, type ^m or ^b (respec-
tively) before the word.

Moving to a bookmark
Software that provides a bookmark function lets you jump to 

any named bookmark using a go to or jump to function. In Win-
dows, the usual keyboard shortcut is Control+G; on the Mac, it’s 
Command+Option+G. If  you prefer, open the Find dialog box 
(Control/Command+F), and select the Go To tab. Both in Word 
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and in software that doesn’t provide bookmarks, you can accom-
plish the same result by using symbols or words as placeholders 
and searching for those targets. An ideal bookmark is something 
that won’t appear in the file, because you want to avoid having 
to skip repeatedly over normal uses of  those characters in the 
text. Typing special characters around a marker makes it stand 
out and makes it easier to find; consider, for example, [continue] 
or &check this&. Such phrases are good choices because they also 
clearly identify the bookmark’s role. If  you use such bookmarks, 
add a reminder in your revision checklist to remove them when 
you’ve addressed each problem and add another reminder to en-
sure that you haven’t missed any during your final revision.

To use Word’s built-in bookmark function, position the cur-
sor at the desired location, and then:
•	 Windows: Ribbon > Insert tab > Bookmark, then name 

the bookmark.
•	 Mac: Insert menu > Bookmark, then name the bookmark.

To move to a bookmark, use the Control+G and Com-
mand+Option+G keystrokes, then type the bookmark name. 
The dialog box also lets you go to other useful things such as 
sections, lines, comments, and tables. To avoid the need to pass 
through this dialog box each time you need it, record a macro 
that performs all the necessary steps, including closing the dialog 
box, and assign a keystroke.

Moving to a specific page
Most go to functions also let you jump to a specific page. 

Word offers this option in both the Windows and Mac versions. 
If  you prefer to use the mouse, many programs that provide a 
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page number at the bottom of  the screen let you double-click 
the page number or open a popup menu beside the page num-
ber and select a page. Word 2019 for Mac no longer provides 
this shortcut.

Returning to your previous position

Getting back to where you started: Word offers a nif-
ty shortcut (Shift+F5) that steps backward, one jump at a 
time, to previous positions where you changed text. Unfor-
tunately, Word frequently gets confused (particularly if  you 
insert a comment) and loses track of  these positions. This 
means that it’s wise to manually insert a bookmark to en-
sure that you can easily return to your starting point.

If  you need to temporarily stop writing or revising so you 
can move elsewhere in the document (e.g., to confirm the word-
ing of  a chapter title so you can type the correct cross-reference), 
it’s easy to leave a bookmark in the file and use the Find func-
tion to find and return to that bookmark. I’ve standardized on [ 
] (two square brackets) or <> (two angle brackets) because both 
are short, easy to type, and unlikely to occur in anything that I 
write or edit. I created the keyboard shortcut Control+Shift+B 
(memory aid: shift the cursor to the bookmark) to move me in-
stantly to that bookmark. An additional benefit is that Word 
highlights the bookmark characters when it finds them, so I can 
delete them in a single keystroke by pressing the Delete key. It 
took me a few weeks of  practice to learn to automatically insert 
a bookmark whenever I was about to move elsewhere in the doc-
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ument, but given how often I do this every day, it saves me an 
enormous amount of  time each week.

Really Big Jumps
Sometimes you actually want to jump much farther than 

within a document—between files or programs, for example. 
Try the following:

Recently used files (across all programs)
Both the Mac and Windows let you display recently accessed 

documents for the operating system as a whole:
•	 Windows: Recently used documents or favorite documents 

are displayed under the Start menu. For each program in 
that menu, right-click on the program name to show these 
files.

•	 Mac: Under the Apple () menu, the Recent Items option 
initially only shows recently used programs. To add recently 
used documents: Apple menu > System Preferences > General 
tab > Recent items menu. Choose a number.

Recently used files (for the current program)
Most software now provides a Recent files or Recent items 

option under the File menu that provides access to the files you 
recently worked on:
•	 Windows: To implement this feature, Ribbon > File menu 

> Options > Advanced tab > Display subheading. Choose a 
number from the menu beside Show this number of recent 
documents.
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•	 Mac: The number appears to be fixed at 15, but if  you 
open the File menu and select Open Recent, the More... op-
tion provides access to all documents you’ve opened in re-
cent weeks.

Switching to the desktop: To move to the desktop in 
Windows, press Windows key+M or Windows key+D to 
minimize all Windows (move them to the status bar). Any 
new keystrokes (e.g., typing the name of  a document to se-
lect that document) will now apply to the desktop. Press 
Alt+Tab to return to Word. On the Mac, Command+F3 
will move you to the desktop if  Mission Control is enabled 
in the control panels. If  not, F11 will hide all application 
windows and reveal the Desktop. Click on the Desktop to 
access its contents. Press F11 again to restore the open win-
dows.

Frequently used files
It’s helpful to place shortcuts to frequently used documents 

in convenient locations, such as on your desktop, or in the Start 
menu (Windows). To create shortcuts (Windows) or aliases (Mac-
intosh) that point to a file:
•	 Windows: Right-click the file and select Create Shortcut. 

Drag the shortcut to a convenient location. To make it ap-
pear under the Start menu, drag the shortcut into the Start 
menu.

•	 Mac: Right-click on the file and select Make Alias or select 
it and press Command+L to create an alias. Although you 
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can’t add individual documents to the Apple () menu or the 
Dock, you can create a folder that holds these shortcuts and 
drag that folder into the right side of  the Dock (beside the 
Trash icon) or into the Sidebar of  a Finder window.

A note of  caution about shortcuts and aliases: 
Shortcuts and aliases point to a file; they are not the file it-
self. Thus, be careful to ensure that you have included the 
actual file (not its shortcut or alias) in your backups.

•	 Libraries: Some software (though not Word) also offers a 
“library” function that provides fast access to frequently used 
files.
Word used to offer a separate Work menu that you could add 

to your menu bar, beside the other menus, to provide access to 
documents that you use frequently. This menu is no longer avail-
able, but there’s an alternative:
•	 Windows: Beside recent documents displayed under the 

File menu, you’ll see a push-pin icon. Click that icon and the 
currently open file will move to the top of  the menu and stay 
there until you click the push-pin again to unpin the docu-
ment.

•	 Mac: Display the list of  recent documents and select More... 
to display all recent documents. You can now right-click a 
document and select Pin or Unpin to (respectively) retain it on 
or remove it from the menu. Pinned documents are accessed 
from the list of  recent documents, but you have to select the 
Pinned tab in this dialog box to see them.
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Once you’ve added documents to the menu, you can open 
any document that you added to the menu without having to 
first find it on your computer. If  you move the document, the 
link will be broken and you’ll have to find it again in its new lo-
cation.

Other open windows within an application
In most software, you can switch between two open docu-

ments via the Window(s) menu. In Windows, the standard key-
board shortcut for switching between documents is Alt+Tab; for 
the Macintosh, the keystroke is Command+` (the accent charac-
ter below the Esc key on most keyboards).

Other open programs
If  you’re documenting software or researching something 

on the Web and must switch repeatedly between the software 
or Web browser and your word processor, it’s particularly useful 
to be able to switch between programs using the keyboard. The 
shortcuts are Alt+Tab for Windows and Command+Tab for the 
Macintosh; press that shortcut repeatedly until you reach the de-
sired program.

Experiment!
Some of  these shortcuts can be expanded or customized with 

a little creativity. For example, if  you frequently have to move to 
the next instance of  a particular heading style, record a macro 
that opens the Find dialog box and defines the search target as 
text formatted using that heading style, then create a keyboard 
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shortcut for that macro. (For details on finding text properties 
such as heading styles, see Chapter 12. For details on recording 
macros, see Chapter 14.) Pay enough attention to how you work 
so that you can identify the kinds of  jumps that you need to do 
repeatedly, then find or develop a keyboard shortcut that lets you 
make those jumps quickly and easily. The time savings can be 
enormous. Plus, as a bonus, you’ll impress the heck out of  your 
friends and colleagues when they see you doing this.


